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� WARNING �
Thank you for purchasing automation equipment from AutomationDirect.com™, doing business as,
AutomationDirect. We want your new automation equipment to operate safely. Anyone who installs
or uses this equipment should read this publication (and any other relevant publications) before
installing or operating the equipment.

To minimize the risk of potential safety problems, you should follow all applicable local and national
codes that regulate the installation and operation of your equipment. These codes vary from area to
area and usually change with time. It is your responsibility to determine which codes should be
followed, and to verify that the equipment, installation, and operation is in compliance with the latest
revision of these codes.

At a minimum, you should follow all applicable sections of the National Fire Code, National Electrical
Code, and the codes of the National Electrical Manufacturer's Association (NEMA). There may be
local regulatory or government offices that can also help determine which codes and standards are
necessary for safe installation and operation.

Equipment damage or serious injury to personnel can result from the failure to follow all applicable
codes and standards. We do not guarantee the products described in this publication are suitable for
your particular application, nor do we assume any responsibility for your product design,
installation, or operation.

These products are not fault-tolerant and are not designed, manufactured or intended for use or resale
as online control equipment in hazardous environments requiring fail-safe performance, such as in the
operation of nuclear facilities, aircraft navigation or communication systems, air traffic control, direct
life support machines, or weapons systems, in which the failure of the product could lead directly to
death, personal injury, or severe physical or environmental damage ("High Risk Activities").
AutomationDirect specifically disclaims any expressed or implied warranty of fitness for High Risk
Activities.

For additional warranty and safety information, see the Terms and Conditions section of our catalog.
If you have any questions concerning the installation or operation of this equipment, or if you need
additional information, please call us at 770-844-4200.

This publication is based on information that was available at the time it was printed. At
AutomationDirect we constantly strive to improve products and services, so we reserve the right to
make changes to the products and/or publications at any time without notice and without any
obligation. This publication may also discuss features that may not be available in certain revisions of
the product.

Trademarks
This publication may contain references to products produced and/or offered by other companies.
The product and company names may be trademarked and are the sole property of their respective
owners. AutomationDirect disclaims any proprietary interest in the marks and names of others.

Copyright 2009 AutomationDirect, All Rights Reserved
No part of this manual shall be copied, reproduced, or transmitted in any way without the prior,
written consent of AutomationDirect. AutomationDirect retains the exclusive rights.
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� AVERTISSEMENT �
Nous vous remercions d'avoir acheté l'équipement d'automatisation de AutomationDirect, en faisant des
affaires comme, AutomationDirect. Nous tenons à ce que votre nouvel équipement d'automatisation
fonctionne en toute sécurité. Toute personne qui installe ou utilise cet équipement doit lire la présente
publication (et toutes les autres publications pertinentes) avant de l'installer ou de l'utiliser.

Afin de réduire au minimum le risque d'éventuels problèmes de sécurité, vous devez respecter tous les codes
locaux et nationaux applicables régissant l'installation et le fonctionnement de votre équipement. Ces codes
diffèrent d'une région à l'autre et, habituellement, évoluent au fil du temps. Il vous incombe de déterminer les
codes à respecter et de vous assurer que l'équipement, l'installation et le fonctionnement sont conformes aux
exigences de la version la plus récente de ces codes.

Vous devez, à tout le moins, respecter toutes les sections applicables du Code national de prévention des
incendies, du Code national de l'électricité et des codes de la National Electrical Manufacturer's Association
(NEMA). Des organismes de réglementation ou des services gouvernementaux locaux peuvent également vous
aider à déterminer les codes ainsi que les normes à respecter pour assurer une installation et un fonctionnement
sûrs. 

L'omission de respecter la totalité des codes et des normes applicables peut entraîner des dommages à
l'équipement ou causer de graves blessures au personnel. Nous ne garantissons pas que les produits décrits dans
cette publication conviennent à votre application particulière et nous n'assumons aucune responsabilité à l'égard
de la conception, de l'installation ou du fonctionnement de votre produit.

Nos produits ne sont pas insensibles aux défaillances et ne sont ni conçus ni fabriqués pour l'utilisation ou la
revente en tant qu'équipement de commande en ligne dans des environnements dangereux nécessitant une
sécurité absolue, par exemple, l'exploitation d'installations nucléaires, les systèmes de navigation aérienne ou de
communication, le contrôle de la circulation aérienne, les équipements de survie ou les systèmes d'armes, pour
lesquels la défaillance du produit peut provoquer la mort, des blessures corporelles ou de graves dommages
matériels ou environnementaux («activités à risque élevé»). La société AutomationDirect nie toute garantie
expresse ou implicite d'aptitude à l'emploi en ce qui a trait aux activités à risque élevé.

Pour des renseignements additionnels touchant la garantie et la sécurité, veuillez consulter la section Modalités
et conditions de notre documentation. Si vous avez des questions au sujet de l'installation ou du
fonctionnement de cet équipement, ou encore si vous avez besoin de renseignements supplémentaires, n'hésitez
pas à nous téléphoner au 770-844-4200.

Cette publication s'appuie sur l'information qui était disponible au moment de l'impression. À la société
AutomationDirect, nous nous efforçons constamment d'améliorer nos produits et services. C'est pourquoi nous
nous réservons le droit d'apporter des modifications aux produits ou aux publications en tout temps, sans
préavis ni quelque obligation que ce soit. La présente publication peut aussi porter sur des caractéristiques
susceptibles de ne pas être offertes dans certaines versions révisées du produit.

Marques de commerce
La présente publication peut contenir des références à des produits fabriqués ou offerts par d'autres entreprises.
Les désignations des produits et des entreprises peuvent être des marques de commerce et appartiennent
exclusivement à leurs propriétaires respectifs. AutomationDirect nie tout intérêt dans les autres marques et
désignations.

Copyright 2007 AutomationDirect, Tous droits réservés
Nulle partie de ce manuel ne doit être copiée, reproduite ou transmise de quelque façon que ce soit sans le
consentement préalable écrit de la société AutomationDirect. AutomationDirect conserve les droits exclusifs à
l'égard de tous les renseignements contenus dans le présent document.
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� ADVERTENCIA �
Gracias por comprar equipo de automatización de AutomationDirect. Deseamos wue su nuevo
equipo de automatización opere de manera segura. Cualquier persona que instale o use este equipo
debe leer esta publicación (y culaquier otra publicación pertinente) antes de instalar u operar el
equipo. 

Para reducir al mínimo el potencial de riesgo debido a problemas de seguridad, debe seguir todos los
códigos de seguridad locales o nacionales aplicables que regulan la instalación y operación de su
equipo. Estos códigos varian de área en área y usualmente cambian con tiempo. Es su responsabilidad
el determinar cuales códigos deben ser seguidos, y verificar que el equipo, instalación, y operación
estén en cumplimiento con la revisión mas reciente de estos códigos.
Como mínimo, debe seguir las secciones aplicables del Código Nacional de Incendio, Código
Nacional Eléctrico, y los códigos de (NEMA) la Asociación Nacional de Fabricantes Eléctricos. Puede
haber oficinas de regulación local o del gobierno que pueden asistir en determinar cuales códigos y
normas son necesarios para una instalación e operación segura. 

Falta de seguir todos los códigos y normas aplicables, puede resultar en daños al equipo o lesiones
serias a personas. No garantizamos los productos descritos en esta publicación a ser adecuado para su
aplicación en particular, ni asumimos ninguna responsabilidad por el diseño de su producto, la
instalación, u operación.

Nuestros productos no son tolerantes a fallas y no han sido diseñados, fabricados o intencionados para
el uso o reventa como un equipo de control de línea en ambientes peligrosos que requieren una
ejecución sin fallas, tales como operación en facilidades nucleares, sistemas de navegación aérea, o de
comunicación, control de trafico aéreo, maquinas de soporte de vida, o sistemas de armas, en las cuales la
falla del producto puede resultar directamente en muerte, heridas personales, 
o daños físicos o ambientales severos ("Actividades de Alto Riesgo"). AutomationDirect específicamente
rechaza cualquier garantía ya sea expresada o implicada para actividades de alto riesgo.

Para información adicional acerca de garantía e información de seguridad, vea la sección de Términos
y Condiciones de nuestro catalogo. Si tiene alguna pregunta sobre instalación u operación de este
equipo, o si necesita información adicional, por favor llámenos al Lada (001) en (EEUU), número
770-844-4200.

Esta publicación esta basada en información disponible al momento de impresión. En
AutomationDirect nos esforzamos constantemente para mejorar nuestros productos y servicios, así
que nos reservamos el derecho de hacer cambios al producto y/o a las publicaciones en cualquier
momento sin  notificación y sin ninguna obligación. Esta publicación también puede
discutir características que no estén disponibles en ciertas revisiones del producto.

Marcas Registradas
Esta publicación puede contener referencias a productos producidos y/u ofrecidos por otras
compañías. Los nombres de las compañías y productos pueden tener marcas registradas y son
propiedad única de sus respectivos dueños. AutomationDirect, renuncia cualquier interés
propietario en las marcas y nombres de otros.

Copyright 2009 AutomationDirect, Todos los Derechos Reservados
No se permite copiar, reproducir, o transmitir de ninguna forma ninguna parte de este manual sin
previo consentimiento por escrito de AutomationDirect. 
AutomationDirect retiene los derechos exclusivos a toda la información incluida en este
documento.
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AUTOMATIONDIRECT END USER LICENSE AGREEMENT
AND LIMITED WARRANTY

The software accompanying this license agreement (the Software) is
the property of AutomationDirect, or its suppliers, and is protected
by United States and International Copyright laws and International
treaty provisions.  No ownership rights are granted by this Agreement
or possession of the Software.  Therefore, you must treat the Licensed
Software like any other copyrighted material (e.g., a book or musical
recording), except that you may make a single copy for backup or
archival purposes.  Your rights and obligations in its use are described
as follows:

1. You may use and display this software on a single computer.

2. You may make one copy of the software for archival purposes or you
may copy the software onto your hard disk and hold the original for
archival purposes.

3. You may not modify or attempt to reverse engineer the software, or
make any attempt to change or even examine the source code of the
software.

4. You may transfer the software to another computer using the utilities
provided.  However, the software must be used on only a single computer
at one time.

5. You may not give or distribute copies of the software or written
materials associated with the software to others.

6. You may not sub-license, sell, or lease the software to any person or
business.

Return Policy

The original licensee of the software can return it within thirty (30)
days of purchase.  Please call us for a Return Material Authorization
Number.

Limited Warranty

AutomationDirect does not warrant that the Software will be error
free, that it will satisfy your planned applications or that all defects in
the Software can be corrected.      
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AutomationDirect provides information or assistance regarding the use
of the Software or otherwise, AutomationDirect is not assuming the
role of engineering consultant.  AutomationDirect disclaims
responsibility for any errors or omissions arising in connection with
engineering in which its Software or such information or assistance is
used.

The foregoing is the sole and exclusive warranty offered by
AutomationDirect.

AutomationDirect disclaims all other warranties, express or implied,
including but not limited to the implied warranties of merchantability
and fitness for a particular purpose, with regard to the licensed software
and all accompanying materials.

In no event shall AutomationDirect be liable for incidental or
consequential damages, including lost profit, lost savings, lost
opportunities, or other incidental or consequential damages arising out
of the use or inability to use the licensed software, even if
AutomationDirect has been advised of the possibility of such damages.

AutomationDirect's entire liability shall be, at AutomationDirect's
option, either (a) return of the price paid for the Software (or
component), or (b) repair or replacement of the Software (or
component) that does not meet AutomationDirect's Limited Warranty
and which is returned to AutomationDirect within the warranty
period.  This shall be the sole and exclusive obligation of
AutomationDirect and your sole and exclusive remedy with respect to
any such failure.  The Limited Warranty is void if failure of the
Software (or component) has resulted from accident, abuse or
misapplication.

Trademarks

Microsoft® and Microsoft Excel® are registered trademarks,
Windows™ is a trademark of Microsoft Corporation.

DataWorx® is a registered trademark of BizWareDirect, Inc.
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Document History
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First Edition May 2009 Original
First Edition, Rev. A Feb 2014 Added Windows 7 support
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1.0 Introduction

DataWorx P3K provides an easy and inexpensive way to
collect data from your Productivity3000 PAC by
connecting it to enterprise database systems for
Productivity3000/database connectivity. Industrial devices
are able to conduct their own database operations, and
devices can be programmed and changed from the
database. With DataWorx™P3K, settings from industrial
devices can even be stored in the database, then retrieved
and sent back to the Device for future use.   The DataWorx
P3K software package is unique because it offers report-by-
exception data collection rather than the typical method of
data collection through polling. The report-by-exception
method allows the Device complete control to store the
data to a computer database or to store it locally if the
network is down. Report by exception eases network traffic
because it sends information only when needed.

Hardware Required Software Required

� Pentium II with 128 megabytes of
ram 

� The Server requires Windows NT
(SP5 or higher),  2000, XP, Vista or
7 (32 and 64 bit)

� 10 megabytes of free hard-disk
space

� The Server requires Internet
Explorer 6.0 or higher

� Productivity3000 PAC � The Monitor can run on Windows
98, NT, 2000, XP, Vista or 7 (32 and
64 bit)
� Compatible with Microsoft Access

or Microsoft SQL Server databases
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2.0 Installation

Before beginning the software installation, make sure that
the devices and Server/Monitor computers are connected to
the network. Decide what type of installation you want:

1. Server and Monitor on same computer

a. This might be the only option if there is only one
computer.
b. Even if you plan on hosting the Server and
Monitor on different computers, both applications
may be installed on the Server for quick and easy
installation and configuration.

2. Server and Monitor on different computers

a.This option is ideal when the physical location of
the Server is not easily accessible.

b. If you choose this setup, note the IP address or
name of the Server so it can be accessed later

DataWorx P3K software is available on the CD. To install
DataWorx P3K, insert the CD into your PC’s CD drive.
The CD should start automatically and open the installation
window.

Note: If the CD does not start automatically, go to your Windows
START button, select RUN, and type:

E:\setup.exe

Change the letter “E” to correspond to the letter for your CD drive.
Then click OK, and the program will start.
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Read the license agreement that appears onscreen. Make
sure you understand and agree with the written statement
before moving on:

Click on DataWorx P3K to start the installation program
shown below. Click Next:
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After reading and understanding the license agreement,
check the box next to the statement, "Yes, I agree with the
terms of this license agreement." Click Next:

A screen will appear that says, “Readme Information.” This
screen contains important information regarding the
DataWorx P3K software that may be pertinent to you. After
reading the information, click the Next button:
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A prompt for the DataWorx P3K Destination Folder will
appear. By default the Destination Folder path is set to 

C:\Program Files\BizwareDirect, Inc\DataWorx P3K. The
location of the DataWorx P3K files can be changes by
clicking Browse and selecting an alternative folder. 

Once the Destination Folder has been determined, click
Next.
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You will now be prompted to enter the Setup Type. 

There are three Setup Types: Monitor, Server, or Server and
Monitor.  If a type from the list is selected, a description of
that type will appear on the right-hand side of the screen. If
you want the Server and Monitor on the same computer,
click on the Server and Monitor option. If you want to install
only the Server, select Server. Or, you may decide to install
the Monitor only. Choose this option if remote access to a
DataWorx Server is available.

Once the Setup Type has been determined, click Next.  You
will be prompted to input the Program Group.  This is
where shortcuts will be installed. By default, the program
group is DataWorx P3K, but the program group may be
changed by entering it in the text box:
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Click Next, and you will be prompted to begin the
installation process. By clicking the Back button, all of the
installation settings may be reviewed before continuing with
the installation.  Once satisfied with the installation settings,
click Next:
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After clicking the Next button, a meter which indicates the
installation progress will appear:

You can stop the installation process by clicking the Cancel
button.

After the installation is complete, a notification will appear,
confirming that the installation has been successful. Click
Finish to exit the DataWorx P3K installer:
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3.0 Registration
REGISTRATION INSTRUCTIONS

• Ensure that the Server is running
• Start the Monitor and connect to the Server
• Go to 
Help -> Registration: 

In the registration window, copy the registration key by
selecting the key, pressing the right mouse button and
selecting copy.

Note: If your PC does not have an active Internet connection,
please write down the key provided in the registration window
below. Then, go to a PC that does have an Internet connection
and type your information into the Web page as described.

Registration Key:
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With your Internet browser, go to: 

www.bizwaredirect.com/dataworxregistration.aspx.

Paste the registration key into the Key field on the Web
form. You must also enter the serial number, which is
located on the back of the software CD case:

Click the Create Registration button. If the information was
entered correctly, your newly assigned key will appear in the
bottom field:
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Copy the assigned key. Return to the DataWorx registration
screen, and paste the assigned key into the Key field. You
must also enter the serial number, which is located on the
back of the software CD case:

Assigned Key:
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Click OK. The registration process is now complete.

A success message in the registration window should show
your registration status: 

Next, click the Register button:
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4.0 Hardware

REQUIREMENTS 

DataWorx P3K will work with the Productivity3000 PAC.
Once   DataWorx P3K is set up and configured, the PAC
can add, retrieve, update and delete database records.
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5.0 Ladder Logic

5.1 Report by Exception
OVERVIEW

The DataWorx P3K software package is unique because it
offers report-by-exception data collection rather than the
typical method of data collection through polling. With
report-by-exception technology, the Productivity3000 PAC
has complete control over data logging. The device will
send information only when needed, whereas with polling,
the computer maintains control and constantly queries the
device for data. As a result of this architecture, report-by-
exception technology eases network traffic.
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5.2 Productivity3000 

The AutomationDirect Productivity3000 programming environment
uses a DataWorx P3K Request Block to communicate with the
DataWorx Server.  An example DataWorx P3K Request Block is
shown below.

Once the database and the DataWorx P3K Server have been set up
and the DataWorx P3K Server configuration has been exported, 
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insert DWX instructions in the ladder to execute the procedures
that were defined. Use the DataWorx Project field to import the
DWX file that you just created.  Importing this file populates the
procedure selector with all the available procedures that were
defined in the DataWorx P3K Server.  In this case, Procedure 1:
Shipment Tracking is selected and will automatically populate the
Mapping Table, Where Table and SQL View information.

In this example, shipping box data will be selected from the database
and written to Productivity3000 tags.  Before this rung is executed,
set the value of the Productivity3000 tag id to be the desired box id
number.  Then execute the rung.  The Productivity3000 tags in the
Mapping field (i.e. trackingnumber, weight, dimensions, numitems)
will now be updated with the values retrieved from the database for
the respective box id.

Note: Please refer to the Productivity3000 manual for 
complete details on configuring the DataWorx P3K block.



17

DataWorx P3K

6.0 DataWorx P3K

6.1  Server
OVERVIEW

The DataWorx P3K Server's primary function is to listen to
devices and record the data into either a database or text file.
DataWorx P3K is also capable of performing database
operations.

The desired format of the data file is set using the DataWorx
P3K Monitor. For more information on configuring the
Server with the Monitor, please refer to section 6.2:
Monitor.

6.1.1 Installing Service
The DataWorx P3K Server needs to be both installed and
running, to operate without user intervention.  

To install the Server:

Click the Start Button -> Program Files -> DataWorx P3K -
> DataWorx P3K Server
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When installation is finished, this window should appear. It
shows the status of the Server is “Installed, Stopped.”

The DataWorx P3K Server
window should appear. Click
the Install button:

Note: Installation alone does
not start the DataWorx P3K
Server. For instructions on
starting the Server, please
refer to section 6.1.2:
Running Service.
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6.1.2 Running Service

In the DataWorx P3K Server
window, click the
Start/Continue button. This
window should appear,
showing the Server’s status as,
“Installed, Running.” The
Server is now running and
should operate without user
intervention.

Once the DataWorx P3K Server has been installed, it must
be activated in order to operate without user intervention. If
you do not already have the DataWorx P3K Server window
open:

Click the Start Button -> Program Files -> DataWorx P3K -
> DataWorx P3K Server 
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6.1.3 Pausing Service

Assuming the DataWorx
P3K Server is currently
running, this window will
appear onscreen:

Pausing forces the Server to stop listening for device input.
This feature can be useful when making updates or
configuring the Server because the Server will temporarily
ignore data.

To pause the Server, you must have the DataWorx P3K
Server window open. If you do not already have this
window open:

Click the Start Button -> Program Files -> DataWorx P3K -
> DataWorx P3K Server
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Click the Pause (Stop
Listening) button, and this
window should appear.
The Server is now paused.

Note: Pausing does not
stop the DataWorx P3K
Server from running. To
stop the Server, refer to
section 6.1.4: Stopping.

6.1.4 Stopping Service
Stopping the DataWorx Server will completely shut it down,
rather than just keep it from listening for data. This must be
done before the Server can be uninstalled.

If you do not already have the DataWorx P3K Server
window open:

Click the Start Button -> Program Files -> DataWorx P3K -
> DataWorx P3K Server 
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In the DataWorx P3K Server
window, click the Stop button.
This window should appear.
The Server is now stopped.

6.1.5 Viewing the Error Log 
The DataWorx P3K Server maintains an error log to use as
a diagnostic tool for troubleshooting. 

If  the DataWorx P3K Server Window is not open, open the
Start Menu and select:

Programs -> DataWorx P3K -> DataWorxP3K Server
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In the DataWorx P3K Server window, go to: 

File -> Error Log

The Error Log window will open:

The Error Log window contains any error messages that
were generated by the Server and Monitor programs.  It
serves as a useful troubleshooting tool.
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6.1.6 Uninstalling Service

Once the DataWorx P3K Server
window is open, click on the
Uninstall button. This window
should appear, showing the status as
“Not installed.”

If the DataWorx P3K Server window is not already open:  

Click the Start Button -> Program Files -> DataWorx P3K -
> DataWorx P3K Server
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6.2 Monitor
OVERVIEW

The DataWorx Monitor allows you to configure the
DataWorx P3K Server and control its view options. It also
allows the retrieval of the Server’s data files over a network.
The Monitor can also be used for troubleshooting. Below is
the Monitor’s main screen. Following the screen is a brief
explanation of each of its fields:
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Server Address: This is the field in which to enter the
address of the PC on which the DataWorx P3K Server is
running.

Last Update: This denotes the most recent device input
time.

Status: The Server's locked and listening state is displayed
here.

Devices: A list of the devices which are currently configured
with the Server, as well as the status of each device, will be
displayed here.

Note: Devices will only list the last update. You need to check the
date to verify that you are receiving information as often as you
expect.

Messages: Updates from both the Server and the Monitor
itself are displayed in this field.

DataWorx P3K
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6.2.1 Connecting

Connecting the Monitor to a DataWorx P3K Server
enables you to configure the DataWorx Server and retrieve
its data files. To connect to a DataWorx Server, open the
DataWorx P3K Monitor window. Once the Monitor’s main
screen is open, enter the IP address or name of the Server
you wish to connect to into the field labeled Server Address:

Next, press the Connect button. The Monitor should now
be connected to the Server and configuration and data
retrieval can be completed. If the connection has been
made successfully, the text on the button will change from
Connect to Disconnect, as shown below:
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6.2.2 Configuring

Note: Before configuring the Server, the user must connect to it
from the Main Monitor window.  See section 6.2.1: Connecting

On the DataWorx P3K Monitor screen, go to:

Options -> Configure Server

You should now see a list of the devices (if any) which are
configured for the Server. Here is an example:

Use the Port field to change the port that the DataWorx 
P3K Server listens on for messages.
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To add a device, click Add.  A device configuration window
similar to the following will open. 

The example below reflects information that has already
been filled in by the user.  

Below is an explanation of each field:

IP Address: Denotes the IP Address of the PAC.

Alias (Optional): The user may indicate an alternative 
name for the PAC, which can be easier to 
remember than a cryptic IP Address.

Database Type: Indicates the type of database in which the 
device data will be stored.

• Access: When the Database Type is set to 
“Access,” then the Filename field is available.

The user must specify the path to the Access file 
either by directly editing the Filename field or by 
clicking “Browse” and selecting a path
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• SQL Server: When the Database Type is set to “SQL
Server,” then additional fields are available, as shown
below:

Authentication:  

• If set to “SQL Account,” then the name of the 
SQL Server host machine must be specified in 
the Hostname field, and both the Username
and Password information for the SQL Account 
must be filled in.

• Otherwise, if set to “Local system account,” 
then the user only fills in the Server field.

Database:  The user must select from the 
databases available on the specified SQL Server.

• ODBC:  When the Database Type is set to “ODBC,”
then the DSN field is available.

The user must specify the DSN (Data Source 
Name) by directly editing the DSN field.
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Test DB: Use the “Test DB” button to test the DataWorx 
server connection to the user-specified database, 
without establishing a steady connection.  If 
successful, a “Connection Successful” message box
will open.  Otherwise, a “Connection Failed” 
message box will open.

Connect: Use the “Connect” button to establish a full 
connection to the user-specified database.  If 
successful, the “Connect” button label will update 
to “Disconnect.” Otherwise, a “Connection 
Failed” message box will open.

Device Procedures List: This section displays a list of 
currently stored Device Procedures.  In the 
example above, no Device Procedures have been 
created.

Selected Device Procedure Properties: The tabs in this 
section display the settings for the highlighted 
Device Procedure in the Device Procedures List.  
In the example above, no Device Procedures have 
been created, therefore the tab fields are empty.

Note: For details on creating Device Procedures and the tabs in the
Selected Device Procedure Properties section, refer to “Device
Procedures,” Chapter 8.
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Productivity3000 PAC Tag Database 

From the Device Configuration window, click “Import Tag
Database.”  

The Import Tag Database window will open.  

Click “Import Tags.”  
Then, the Select Productivity3000 Tag Database File 
window will open.  Select the desired Productivity3000 
tag database CSV file and click “Open.”
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The tags from the selected Productivity3000 tag database 
CSV file will be imported into DataWorx P3K and the 
imported tag count will display in the Import Tag 
Database window.

Click “Save” to finish.
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6.2.3 Modifying a Device
A device’s configuration can be modified using the
DataWorx Monitor. To make changes or updates to a
device’s configuration, first open the Monitor window.
Once open, go to:

Options -> Configure Server

You should now see a list of the devices which are
configured to the Server. Here is a sample list of configured
devices:
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Click on the Modify/View button and a device configuration
window will appear. This screen displays all relevant device
configuration data.

Here is an example of a device configuration window:

On this screen, you are able to make changes and updates in
the devices’ configurations. Also included here is the
DataWorx P3K’s database logging option. Once all
necessary changes have been made, click the OK button to
save changes. Or, you may click Cancel to discard the
changes and return the device’s configuration to its previous
state.
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6.2.4 Deleting a Device

To delete a device, you must have the DataWorx P3K
Monitor screen open. Once open, go to:

Options  -> Configure Server

You will then see a list of devices which are configured to
the Server, as in this example:

Select the device you wish to delete and click the Delete
button. If DataWorx receives data from a deleted device it
will log an error due to missing configuration.
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6.2.5 Duplicating a Device
Duplicating is a great time-saving feature for those who
have many devices with similar configurations. This option
allows you to create one device listing, and make several
copies:

In the Monitor window, go
to:
Options -> Configure Server

A list of the devices which are already configured to the
Server should appear:

Choose the device you wish to duplicate and click the
Duplicate button. You should see this window appear,
asking for the Alias and IP Address of the new device. Input
the device information.
Click OK to save and
activate the new
configuration.
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6.2.6 Hiding
Hiding is a convenient feature that allows you to
temporarily place the Monitor out of view for later access,
without closing the application.

To hide the Monitor, go to:
File -> Hide

The DataWorx P3K icon now appears in the computer’s
task bar, at the very bottom of the screen:

When you are ready to restore the application back into
view again, right-click on the icon and select the Restore
option from the list:
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6.2.7 Backing Up and Restoring
Backing up the system’s configuration allows you to safely
restore all of the changes you have made to the Monitor and
Server, in the event of a hardware failure.

To back up the configuration, go to:
Tools  -> Backup Configuration

You will be prompted for a filename. Enter the name and
click Save. Make a note of the filename and location of this
backup configuration, in case you need it for a future
restoration.

In the event that you need to restore your backup
configuration, you can do so by going to:

Tools -> Restore Configuration

You will be prompted for a filename. Enter the filename
you chose during the
backup process and
click Open. The
Server and Monitor
should now be
restored to their
original states.
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If the Server has successfully stopped listening, the status
should now read "Not Listening to Devices.”

To tell the Server to listen, click the Start Listening button.
(If the button reads “Stop Listening,” the Server is already
listening for data.)

To tell the Server to stop listening, click the Stop Listening
button:

6.2.8 Listening
The DataWorx P3K Server maintains listening and not
listening states with regards to device input. You can change
the listening state from the Monitor, as well as from the
Server.

Changing the listening state can be useful when in the
process of installing new devices or changing the
configuration of existing devices. You can prevent the Server
from receiving irrelevant data during these times of
maintenance by stopping its listening state.

If the Server is successfully listening, the status should now
read “Listening to Devices.”
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6.2.9 Locking and Unlocking
Locking is a security feature that allows the user to prevent
unauthorized or unwanted device configurations, or changes
to the Server’s listening state. To lock or unlock the Server,
have the Monitor window open and follow the steps below.

First, click the Lock button:

A screen should appear asking for the lock code (Password):

Enter a code that will be easy for you to remember but hard
for someone else to figure out. Click OK. If the Server has
been successfully locked, the window should now display a
locked status, which looks like this:

When you are ready to unlock the Server for configuration,
or to make changes, click the Unlock button. Enter your
code and click OK.

** WARNING ** There is no way to circumvent this
password protection. Do not lose the lock code.
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Chapter 7 Database Overview
This section is not intended to teach database concepts, but
rather covers basic terminology and operations used in
DataWorx P3K. If the user is familiar with database inserts,
deletes, updates and selects, skip this section and proceed to
Chapter 8, Database Operations Using Device Procedures.

What is a Database?

A database is a collection of tables, and each table stores
records in a row-column format similar to a spreadsheet.
Each column, or field, in a table has a predefined data-type
format. When performing database operations, the user
must ensure that the Device data will conform to the table
column, or field, format. Column data types include text,
integers, floating point numbers and date.

Some types of databases also provide a security system where
the user must login with a username and password in order
to view or modify the contents of a database. Microsoft SQL
Server is one such database that supports logins.

Note: DataWorx works with both Microsoft Access and Microsoft
SQL Server, as well as general ODBC compliant databases. Please
check the company web site at www.bizwaredirect.com, to check
for the addition of other databases, as the software is made
compatible with them.

Not only does a database provide a convenient storage
mechanism for data, but it also provides a commonly used
language for performing operations on database tables. That
language is called Structured Query Language (SQL).
DataWorx P3K uses SQL to perform database operations
based on the information that the Device is sending. 
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It is not necessary for the user to know SQL in order to
conduct database operations using DataWorx P3K.
DataWorx P3K will automatically generate SQL statements.
The user only needs to provide the database table
information along with the Device procedure parameters.
Details on Device Procedures follow shortly, in Chapter 8.

Database Operations

Overview of Database Operations

The four types of database operations available to the
DataWorx P3K user are: Insert, Delete, Update and Select.

Insert: Adds new records to a table in a database. The inserted 
data must conform to the column data type format of 
the table. 

Delete: Removes records from a table in a database. Delete 
requires filter criteria for specific records to be deleted, 
otherwise it will delete all records from a table. See the 
next page for an example illustrating the results for a 
database table where all rows with an order date prior to
1/1/2007 are deleted. 

Update: Modifies existing records in a database table. Update 
requires filter criteria for specific records to be updated, 
otherwise it will update fields of all records in the table 
with a specified value.  See the next page for an example
illustrating the results for a database table where the 
row with order code #59 is updated from “In Transit” to
“Complete.”
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Select: Retrieves records from a database table that meet  the
filter criteria. The Select operation allows the user to view
data in a database table without modifying the records.
Select requires filter criteria so that only data from a specific
record will be retrieved; otherwise, it typically returns all
records in the table. However, DataWorx will only return
the first record; therefore, using a where clause will help to
return only the specific record needed.  For further details,
please refer to “Adding a Device Procedure,” in Chapter 8.

Database Operation Examples - Delete and Update

• Delete Results: All rows, in the database table above, with an order 
date prior to 1/1/2007 have been deleted.  In this case, two rows 

have been deleted.

• Update Results: The row, in the database table above, with Order 
Code #59 has been updated from “In Transit” to “Complete.”
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Note: The amount of data allowed in a DataWorx Request
instruction is limited to 120 words (240 bytes).

Chapter 8 Database Operations Using
Device Procedures

Overview

A Device Procedure created in DataWorx:

• Allows a user to trigger a database operation from the
Device,  based on information provided by the Device. 

• Provides a way for the Device to perform a database
operation using the DataWorx P3K Server as its proxy.

• Enables users to easily and quickly define a database
operation with the Device.

Note: Device Procedures are independent of the database with
which DataWorx is communicating. DataWorx Device Procedures
are NOT stored procedures in SQL.

DataWorx P3K
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The Device Procedure ID is used by the Device to tell the
DataWorx P3K Server which DataWorx Device Procedure
to execute.  

As shown below, there are four types of Device Procedures
in DataWorx, each performing a distinct database
operation.

The DataWorx P3K Server determines which Device
Procedure to run based on the value of the first word of
information sent by the Device. 

Per the above example, DataWorx will do the following,
based on the first word: 

• If = 1, then DataWorx will run “Add Order”

• If = 2, then DataWorx will run “Delete Order”

• If = 3, then DataWorx  will run “Update Order”

• If = 4, then DataWorx will run “Look Up Order Status”
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8.1 Viewing a Device Procedure
Once a user has connected to the database from the Device
Configuration window, any Device Procedures that have
been created will display under the following categories:
Insert, Delete, Select and Update.  The category names are
based on the types of available database operations. 

In the example below, one Device Procedure has been
created.  It is designated to perform an Insert database
operation, its unique ID is 1 and its Alias is “Add Order.”  If
the Device sends DataWorx information starting with 1, the
Device is instructing DataWorx to execute the Device
Procedure that has an ID of 1 and use the rest of the Device’s
data in the operation.

When a Device Procedure is selected from the Device
Procedures List, its properties will be displayed in the read-
only, tabbed Selected Device Procedure Properties section to
the right.  

In the example above, the selected Device Procedure will
perform an Insert database operation.  As indicated on the
General tab, the Device Procedure will insert into the
ORDERS database Table.
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8.2 Adding a Device Procedure
In order to add a new Device Procedure, the user must first
connect to the user-specified database.

Then, click "Add" from the Device Procedures section of
the Device Configuration window. 

The Device Procedure Properties window will open

In the General tab, the user will specify the database Table
that the Device Procedure will use, its unique ID, an
optional Alias and the type of database operation, or Action,
that the Device Procedure will perform.  Other tabs, such as
Mappings, will be used as well, depending on the Action
selected. 

Once the applicable tabs have been filled in, click “OK" to
save the new Device Procedure, or click "Cancel" to discard 
the new Device Procedure.

The following pages provide examples for each database
operation:  Insert, Delete, Update and Select.
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8.2.1 Database Operation - Insert
The Insert operation allows Device data to be directly added to
a database table.

General Tab

To create a Device Procedure that will perform an Insert
database operation:

• Provide the Device Procedure with a unique integer ID.

• Enter a meaningful Name (optional).

• Specify the Table into which the Device data will be inserted.

• Set the Action to be Insert. 

• Select a 32-bit Signed Integer tags for writing a Confirmation.
Refer to 8.2.5 for details.

In the example below, the DataWorx Device Procedure will
insert Device data into the ORDERS table, has a unique ID of
1, has been given the meaningful Name “Add Order” and has
its Action set to Insert.

Next, click the "Mappings" tab.
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Mappings Tab

In the Mappings tab, the user will map the Device tags to the
appropriate database table fields for the Insert operation.

Initially, the fields in the Mappings tab for the new Insert Device
Procedure will be empty.  The user must specify the information
in each column and add a row for each piece of data provided by
the Device.

Below is a description of how each column in the Mappings
tab is used for the Insert database operation:

Field:  Offers a list of database table fields that are available in 
the user-specified database.  The user must select the 
database field into which data from the Device will be 
stored.

Tag Name:  For an Insert operation, it indicates the 
Productivity3000 Tag Name of the data being supplied by 
the Device.  Data in this Tag Name will be inserted into 
the database location specified in the Field column.

Type: Specifies the data type of the Device information, which
is expected to match the data type of the database 
table field selected in the Field column.

Attributes:  If the Type column is set to “Binary,” then this 
field lists a choice of bit positions.  Otherwise, if the Type 
column is set to “ASCII,” then this field lists a choice of 
character lengths.
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In the example below, two mappings to database table fields
have been created for the new Insert Device Procedure.

• The data from the Productivity3000 Tag Name will be stored
in the ORDERS table, in the field named ID. 

SQL Statement Tab

The user may use the SQL Statement tab to review the Insert
database operation.  This tab presents the SQL query statement
that DataWorx has created based on the user-specified settings
made so far in the “General” and “Mappings” tabs. 
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8.2.2 Database Operation - Delete
The Delete operation allows database table entries to be deleted
based on data sent by the Device.

General Tab

To create a Device Procedure that will perform a Delete database
operation:

• Provide the Device Procedure with a unique integer ID.

• Enter a meaningful Name (optional).

• Specify the Table from which the entry will be deleted.

• Set the Action to be Delete. 

• Select a 32-bit Signed Integer tags for writing a Confirmation.
Refer to 8.2.5 for details.

In the example below, the DataWorx Device Procedure will
delete information from the ORDERS table, has a unique ID of
2, has been given the meaningful Name “Delete Order” and has
its Action set to Delete.
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Next, click the "Where" tab.

Where Tab

In the Where tab, the user will specify filter criteria for the Delete
operation based on the Device data.  

Initially, the fields in the Where tab for the new Delete Device
Procedure will be empty.  The user may add a row for each filter
criterion that will apply, based on the data sent by the Device.  

** WARNING**  While filter criteria are optional, if NO filter criteria
are specified in the Where tab for the Delete operation, then when
the Device Procedure runs it will delete ALL entries in the database
table chosen in the General tab.

Below is a description of how each column in the Where tab is
used for the Delete database operation:

Field:  Offers a list of database table fields that are available in
the user-specified database.  The user will select the database
fields being compared to Device data, as part of  each filter
criterion.

Tag Name:  For a Delete operation, indicates the
Productivity3000 database Tag Name of the data being
supplied by the Device.  Data in this tag will be compared to
the database field specified in the Field column.

Data Type: Specifies the data-type of the Device information,
which is expected to match the data-type of the database table
field selected in the Field column.
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Attributes:  If the Data Type column is set to “Binary,” then
this field lists a choice of bit positions.  Otherwise, if the Data 
Type column is set to “ASCII,” then this field lists a choice of 
character lengths.

Operator: Allows the user to specify the mathematical
operator that DataWorx will use to compare the Device data 
to the information in the database table field.  The options 
are: = (Equal To), > (Greater Than), >= (Greater Than or 
Equal To), < (Less Than), <= (Less Than or Equal To) and 
<> (Not Equal To). 

And/Or:  When there are multiple filter criteria, it allows the 
user to specify what combination of the user-defined 
criteria must be met in order to delete a database 
entry based on the Device data.  The available options are 
“And” and “Or.”

In the example below, one filter criterion has been created for
the new Delete Device Procedure.

• In this case, the purpose of the Device Procedure is to delete
orders that have a specific order code.

• The new Delete Device Procedure will compare the contents
of the Productivity3000 Tag Name to the CODE field in the
ORDERS database table.

• Since the Operator is set to “=,” then the Device Procedure
will delete only those entries from the ORDERS table where
the CODE field equals the Tag Name value . 



55

DataWorx P3K

SQL Statement Tab

The user may use the SQL Statement tab to review the Delete
database operation.  This tab presents the delete SQL query
statement that DataWorx has created based on the user-
specified settings made so far in the “General” and “Where”
tabs.
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8.2.3 Database Operation - Update
The Update operation allows a database table to be updated based
on data sent by the Device.

General Tab

To create a Device Procedure that will perform an Update database
operation:

• Provide the Device Procedure with a unique integer ID.

• Enter a meaningful Name (optional).

• Specify the Table whose entries will be updated.

• Set the Action to be Update. 

• Select a 32-bit Signed Integer tags for writing a Confirmation.
Refer to 8.2.5 for details.

In the example below, the DataWorx Device Procedure will update
information in the ORDERS table, has a unique ID of 4, has the
meaningful Name “Update Order” and has its Action set to
Update.
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Mappings Tab

In the Mappings tab, the user will map the Device tags to the
database table fields that will be updated by the Update
operation.

Initially, the fields in the Mappings tab for the new Update
Device Procedure will be empty.  The user must specify the
information in each column and add a row for each database
table field that will be updated based on the Device tag.

Below is a description of how each column in the Mappings
tab is used for the Update database operation:

Field: Offers a list of database table fields that are available in 
the user-specified database.  The user must select the 
database table field that will be updated.

Tag Name:  For an Update operation, indicates the 
Productivity3000 Tag Name of the data being supplied by 
the Device.  Data in this Tag Name will replace the 
contents of the database table field specified in the Field 
column.

Type: Specifies the data type of the Device information, 
which is expected to match the data type of the database 
table field selected in the Field column.

Attributes:  If the Type column is set to “Binary,” then this 
field lists a choice of bit positions.  Otherwise, if the Type 
column is set to “ASCII,” then this field lists a choice of 
character lengths.
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In the example below, one mapping to a database table field
has been created for the new Update Device Procedure.

• In this case, the purpose of the Device Procedure is to 
update the status of an order.

• The value in the Productivity3000 Tag Name, the latest new
order status, will replace the contents of the STATUS field in
the ORDERS table.  

Where Tab

In the Where tab, the user will specify filter criteria for the
Update operation based on the Device data, so that only specific
entries in the database table will be updated.  

Initially, the fields in the Where tab for the new Update Device
Procedure will be empty.  The user may add a row for each filter
criterion that will apply, based on the data sent by the Device.  

** WARNING**  While filter criteria are optional, if NO filter
criteria are specified in the Where tab for the Update operation,
then when the Device Procedure runs, it will Update the
Mappings field for ALL entries in the database table chosen in
the General tab.
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Below is a description of how each column in the Where tab is
used for the Update database operation:

Field:  Offers a list of database table fields that are available in 
the user-specified database.  The user will select the 
database fields being compared to Device data, as part of  
each filter criterion.

Tag Name:  For an Update operation,it indicates the 
Productivity3000 Tag Name of the data being supplied by 
the Device.  Data in this Tag Name will be compared to 
the database field specified in the Field column.

Data Type: Specifies the data-type of the Device information,
which is expected to match the data-type of the database 
table field selected in the Field column.

Attributes:  If the Data Type column is set to “Binary,” then 
this field lists a choice of bit positions.  Otherwise, if the 
Data Type column is set to “ASCII,” then this field lists a 
choice of character lengths.

Operator: Allows the user to specify the mathematical 
operator that DataWorx will use to compare the Device 
data to the information in the database table field.  The 
options are: = (Equal To), > (Greater Than), >= (Greater 
Than or Equal To), < (Less Than), <= (Less Than or Equal
To) and <> (Not Equal To). 

And/Or:  When there are multiple filter criteria, it allows the 
user to specify what combination of the user-defined 
criteria must be met in order to update a database 
entry based on the Device data.  The available options are 
“And” and “Or.”
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In the example below, one filter criterion has been created for
the new Update Device Procedure.

• In this case, the purpose of the Device Procedure is to update
the status of an order.

• The new Update Device Procedure will compare the
contents of the Productivity3000 Tag Name to the CODE
field in the ORDERS database table.

• Since the Operator is set to “=,” then the Device Procedure
will update only those entries in the ORDERS table where the
CODE field equals the value of the Productivity3000 Tag
Name.

SQL Statement Tab

The user may use the SQL Statement tab to review the Update
database operation.  This tab presents the Update SQL query
statement that DataWorx has created based on the user-
specified settings made so far in the “General,” “Mappings”
and “Where” tabs.
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8.2.4 Database Operation - Select
The Select operation allows  data from a database table to be
communicated back to the Device, based on a request from
the Device.

General Tab

To create a Device Procedure that will perform a Select database
operation:

• Provide the Device Procedure with a unique integer ID.

• Provide a meaningful Name (optional).

• Specify the Table whose data the Device needs to retrieve.

• Set the Action to be Select.  In this case, the Select Type
option button is automatically set to “First Row,” indicating
that DataWorx will retrieve only data found in the first row in
the database that satisfies the user-specified filter criteria.

• Select a 32-bit Signed Integer tags for writing a Confirmation.
Refer to 8.2.5 for details.

• If checked, the Skip Null Values check box indicates that
DataWorx will not write null values found in the database
fields back to a user-specified Tag.
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In the example below, the DataWorx Device Procedure will
select information from a row in the ORDERS table, has a
unique ID of 3, has the meaningful Alias “Look Up Order
Status,” and has its Action set to Select.

Next, click the “Mappings” tab.

Mappings Tab

In the Mappings tab, the user will map the appropriate database
table fields to the Device Tag for the Select operation.

Initially, the fields in the Mappings tab for the new Select Device
Procedure will be empty.  The user must specify the information
in each column and add a row for each database table field
whose contents will be retrieved and written back to a user-
specified Device Tag.
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Below is a description of how each column in the Mappings
tab is used for the Select database operation:

Field: Offers a list of database table fields that are available in 
the user-specified database.  The user must select the 
database table field whose data will be retrieved.

Tag Name:  For a Select operation, indicates the 
Productivity3000 Tag Name to which the retrieved 
database data will be written.  Any pre-existing data in this 
Tag Name will be replaced with the contents of the 
database table field specified in the Field column.  Recall 
that for a Select operation, the Response type is 
automatically set to Direct.  Therefore, the user will 
directly enter the desired Productivity3000 Tag Name 
into the Tag Name field in the Mappings tab.

Type: Specifies the data type of the Device information, 
which is expected to match the data type of the database 
table field selected in the Field column.

Attributes:  If the Type column is set to “Binary,” then this 
field lists a choice of bit positions.  Otherwise, if the Type 
column is set to “ASCII,” then this field lists a choice of 
character lengths.
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In the example below, one mapping to a database table field
has been created for the new Select Device Procedure.

• In this case, the purpose of the Device Procedure is to
retrieve the status of an order from the database.

• The value in the Productivity3000 Tag Name will be
replaced with the contents of the STATUS field in the
ORDERS table.  

Where Tab

In the Where tab, the user will specify filter criteria for the
Select operation based on the Device data, so that only data
from a specific entry in the database table will be retrieved.  

Initially, the fields in the Where tab for the new Select Device
Procedure will be empty.  The user may add a row for each filter
criterion that will apply, based on the data sent by the Device.  

** WARNING**  While filter criteria are optional, if NO filter
criteria are specified in the Where tab for the Select operation,
then when the Device Procedure runs it will merely retrieve data
from the first record in database table chosen in the General tab.
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Below is a description of how each column in the Where tab is
used for the Select database operation:

Field:  Offers a list of database table fields that are available in 
the user-specified database.  The user will select the 
database fields being compared to Device data, as part of  
each filter criterion.

Tag Name:  For a Select operation, indicates the 
Productivity3000 Tag Name of the data being supplied by 
the Device.  Data in this Tag will be compared to the 
database table field specified in the Field column.

Data Type: Specifies the data-type of the Device information,
which is expected to match the data-type of the database 
table field selected in the Field column.

Attributes:  If the Data Type column is set to “Binary,” then 
this field lists a choice of bit positions.  Otherwise, if the 
Data Type column is set to “ASCII,” then this field lists a 
choice of character lengths.

Operator: Allows the user to specify the mathematical 
operator that DataWorx will use to compare the Device 
data to the information in the database table field.  The 
options are: = (Equal To), > (Greater Than), >= (Greater 
Than or Equal To), < (Less Than), <= (Less Than or Equal
To) and <> (Not Equal To). 

And/Or:  When there are multiple filter criteria, it allows the 
user to specify what combination of the user-defined 
criteria must be met in order to retrieve data from the 
database table entry based on the Device data.  The 
available options are “And” and “Or.”
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In the example below, one filter criterion has been created for
the new Select Device Procedure.

• In this case, the purpose of the Device Procedure is to
retrieve the status of an order that has a specific order code.

• The new Select Device Procedure will compare the contents
of the Productivity3000 Tag Name to the CODE field in the
ORDERS database table.

• Since the Operator is set to “=,” then the Device Procedure
will retrieve only the entry in the ORDERS table where the
CODE field equals the value of the Productivity3000 Tag
Name.

SQL Statement Tab

The user may use the SQL Statement tab to review the Select
database operation.  This tab presents the Select SQL query
statement that DataWorx has created based on the user-
specified settings made so far in the “General,” “Mappings”
and “Where” tabs.
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8.2.5 Procedure Confirmation 

The confirmation operation could send one of two types of results:
A non-negative number for successful execution and a negative
number when the procedure produces an error. The value “-1” is
the recommended default value for the confirmation tags because it
does not refer to any errors. 

If the procedure executed successfully, the confirmation operation
will send a non-negative number to the specified 32-bit integer tag.
This non-negative number is the number of records affected:

Select: The number of records returned.

Insert: The  number of new records created.

Delete: The number of records deleted.

Update:  The number of existing records that were modified.

If the procedure produces an error, the confirmation number will be
a pre-defined negative number. Some of the more likely errors are
listed below:

-2146824564 Data value cannot be converted for reasons
other than sign mismatch or data overflow. For example,
conversion would have truncated data.  

-2146824563 Data value cannot be set or retrieved because
the field data type was unknown, or the provider had
insufficient resources to perform the operation.

-2146824562 Record does not contain this field.

-2146824567  Data value is too large to be represented by the
field data type.
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-2146824569 Data value conflicts with the integrity
constraints of the field.

-2146824554 Operation cannot be performed. Provider
cannot obtain enough storage space.

-2146824568 Insufficient permission prevents writing to the
field.

-2146824566  Data value conflicts with the data type or
constraints of the field.

-2146824565 Conversion failed because the data value was
signed and the field data type used by the provider was
unsigned.

-2147217900  The statement contains an unknown field.
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8.3 Modifying a Device Procedure
To modify a Device Procedure, select it from the Device
Procedures List in the Device Configuration window, and
click “Modify.”  

The Device Procedure Properties window will open and
display the Device Procedure’s settings.

Once the necessary edits have been made in tabs of the
Device Procedure Properties window, either click "OK" to
save the changes to the Device Procedure, or click
"Cancel" to discard the changes to the Device Procedure. 
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8.4 Deleting a Device Procedure
To delete a Device Procedure, select it from the Device
Procedures List in the Device Configuration window, and
click "Delete."

A dialog box will open, asking for confirmation.

Click “Yes” to confirm that the selected Device Procedure 
should be deleted.  Otherwise, click “No,” and the 
selected Device Procedure will remain in the Device 
Procedures List.
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9.0 Troubleshooting and
Miscellaneous Items

Cannot connect to
the Server

� Double check the Server address. It may be
entered incorrectly.
� Verify that both the Server and Monitor
computers are online and can access network
facilities such as e-mail and Internet.

� Ensure that cables are connected
� Verify that computers can access the
Internet by going to a test web site such as
www.yahoo.com

Device is sending
data, but DataWorx
is not receiving
updates

� Verify that the Server is in Listening mode.
You can check this by noting the status. It
should state “Listening to Devices.” If not
listening, click the Start Listening button.

Server is running,
but not receiving
data from device

� Verify that the Server is running, and not
paused.

� If the Server is paused, press the Run
button
� If the Server is running, verify that the
device is correctly configured to send the

right data to the Server

Data files contain
error messages
stating an incorrect
format

� Verify that the device's configured fields
match the Server’s configuration by starting
up the Monitor and going to the Server
configuration.

Please visit us at www.bizwaredirect.com for the latest updates in
troubleshooting tips.

Problem Solutions


